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About this manual T"URNRC K

Other documents Your Global Automation Partner

1 About this manual

The instructions set out how to integrate the excom system into the Centum VP control system
from Yokogawa via PROFIBUS in the event of system redundancy.

Read this manual and the applicable documents carefully before the integration. This will
prevent the risk of personal injury and damage to property. Keep this manual safe during the
service life of the product. If the product is passed on, hand over this manual as well.

The manual describes the possibilities for GSD-based integration from the installation right
through to the handling of the I/0 data and the associated diagnostics. Other applications of
the excom system are described in addition to the general integration:

Set up system redundancy
Set parameters
Load parameters to the device

Keep these instructions safe during the service life of the product. If the product is passed on,
pass on these instructions as well.

1.1 Target groups

These instructions are written for specifically trained personnel and must be read carefully by
anyone entrusted with the installation, commissioning, operation, maintenance, disassembly or
disposal of the device.

1.2 Explanation of symbols used
The following symbols are used in these instructions:

DANGER
DANGER indicates a dangerous situation with high risk of death or severe injury if
not avoided.

WARNING
WARNING indicates a dangerous situation with medium risk of death or severe
injury if not avoided.

CAUTION
CAUTION indicates a dangerous situation of medium risk which may result in minor
or moderate injury if not avoided.

NOTICE
NOTICE indicates a situation which may lead to property damage if not avoided.

NOTE
NOTE indicates tips, recommendations and useful information on specific actions
and facts. The notes simplify your work and help you to avoid additional work.

CALL TO ACTION
This symbol denotes actions that the user must carry out.

RESULTS OF ACTION
This symbol denotes relevant results of actions.

Y R B PP

1.3 Other documents
Besides this document the following material can be found on the Internet at www.turck.com:

Data sheet

Quick Start Guides
excom manuals
Approvals
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14 Feedback about these instructions

We make every effort to ensure that these instructions are as informative and as clear as pos-
sible. If you have any suggestions for improving the design or if some information is missing in
the document, please send your suggestions to techdoc@turck.com.
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2 Notes on the system

2. System identification
This manual applies to the Turck I/O system excom.

2.2 Turck service

Turck supports you in your projects — from the initial analysis right through to the commission-
ing of your application. The Turck product database at www.turck.com offers you several
software tools for programming, configuring or commissioning, as well as data sheets and CAD
files in many export formats.

The contact data for Turck branches is provided at [ 54].
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For your safety TUURCK

Notes on Ex protection Your Global Automation Partner

3 Foryour safety

The product is designed according to state of the art technology. Residual hazards, however,
still exist. Observe the following safety instructions and warnings in order to prevent danger to
persons and property. Turck accepts no liability for damage caused by failure to observe these
safety instructions.

3.1 Intended use

The excom I/0O system can be integrated on a GSD basis via PROFIBUS into the Centum VP
control system from Yokogawa.

The device must only be used as described in these instructions. Any other use is not in accord-
ance with the intended use. Turck accepts no liability for any resulting damage.

3.2 General safety instructions

The device must only be fitted, installed, operated, parameterized and maintained by trained
and qualified personnel.

Only use the device in compliance with the applicable national and international regula-
tions, standards and laws.

The device meets the EMC requirements for the industrial areas. When used in residential
areas, take measures to prevent radio frequency interference.

Only combine devices for which the technical data is suitable for joint use.

Faulty repairs can lead to the device failing and to accidents leading to property damage and
personal injury. Do not interfere with or modify the system components. These devices are
not intended for repair. Take defective devices out of operation and send them to Turck for
fault analysis. Observe our return acceptance conditions when returning the device to Turck.

3.3 Notes on Ex protection

Only use the device in Ex areas when installed in the appropriate protective housing.
Observe national and international regulations for explosion protection.

When using the device in Ex areas, the user must have knowledge of explosion protection
(IEC/EN 60079-14 etc.).

Only use the device within the permissible operating and ambient conditions (see certifica-
tion data and Ex approval specifications).

Cables and terminals with intrinsically safe circuits must be indicated — use light blue for
color-coding. Separate cables and terminals from non-intrinsically safe circuits or isolate
accordingly (IEC/EN 60079-14).

Complete certification of intrinsic safety.

Never connect equipment to intrinsically safe circuits if this equipment was previously used
once in non-intrinsically safe circuits.

Please follow the instructions for use for the built-in equipment.
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Requirements Your Global Automation Partner

4 Integrating the excom system with Centum VP
4. Requirements

Hardware used

This example uses the following hardware:

Yokogawa hardware
2 x PROFIBUS module APL121

Turck hardware

MTO08-N module rack

2 x Gateway GDP-N/FW2.3
DM80-N digital I/0 module
DO40-N digital output module
AIH40-N analog input module
AOH40-N analog output module
PROFIBUS cable

—DM80-N
GDP-N/FW2.3 —DO40-N

—AIH401-N
PSM24-N.1 -2 —AOH401-N | ©
[

00 o
cooo0
00000

000000000
cooo0
00000
00000

C]

MTO08-N

Fig. 1: Example setup of the excom station
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Software used

This example uses the following software:

Yokogawa software

© CENTUM VP R6
© SYCON.net

Turck software

© GSDfile vV2.0.4
© Gateway firmware V2.3.3.0
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Installing the GSD file

Your Global Automation Partner

42  Installing the GSD file

The GSD file for the excom system is available as a zip file for download from www.turck.com.
»  Unpack the zip file.
Proceed as follows to install the GSD file:

» Opening Centum VP.

» Inthe All Folders project tree, select the node that has an FCS (Field Control Station) and
the two PROFIBUS modules ALP121.

» Double-click the NODE1 node.

» Inthe Opened Folder main window: NODE1 double-click the 3ALP121 PROFIBUS mod-
ule.

System View (CENTUM VP) - NODE1
File Edit View Tools Load Project FCS HIS Help

R 2] |=|mla 2@ X
Folders ed Folder : NODE1
=-FF SYSTEM VIEW Name | Type | Modified

=-F MYPJT B 1ALF111 ALF111{Foundation Fieldb...  2022/07/05 00:01
- COMMON Bil2AaLF1m ALF111{Foundation Fieldb...  2022/07/05 00:02
&5 BATCH B 3ALP121 ALP121(Profibus-DP Comm... 2023/01/17 20:56 |

=) ﬁ_] FCS0102 WR3ALP121Dup ALP121(Profibus-DP Comm._.. 2023/01/17 20:56
-~ CONFIGURATION | g5 n 141+ AAI141-H(16Channel Curr...  2022/07/05 00:02

@ 5;;- SEQ_LIBRARY B6AAI543H AAI543-H(16Channel Cur..  2022/07/05 00:03

: &) 7ADV551-P ADV551-P(32-Channel Stat... 2022/07/05 00:03
EssADV151P ADV151-P(32-Channel Stat... 2022/07/05 00:04

na, FUNCTION_BLOCK
---c‘.ﬂ. DISPLAY
& = HiSp164

Fig. 2: Open the project

=  The Start Builder window opens.
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»  Select the PROFIBUS-DP Configurator.
» Click OK.

Start Builder

(* PROFIBUS-DP Configurator

(" Communication 1/O Builder and Support Tool

[ ox ]| cne |

Fig. 3: Start Builder

=  The SYCON.net software opens.

»  Select Network = Import Device Descriptions... from the top menu bar.
' SYCON.net - [Pj:MYPJT Stn:FCS0102 Train:1 Node:1 File:3ALP121.edf] *
|| File View Device [ Network | Help
” = | @ " g+ 2725 Add Busline

— 25 Delete Last Busline

_1 Project: Profibug ‘sl Device Catalog...

Import Device Descriptions...
I |

Print Project Data...

Import SyCon-PB/YOKO Project...
e 121[ALP121]<2>(#1)

Fig. 4: Select Import Device Descriptions...

= A window opens in which the GSD file can be selected.
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Installing the GSD file Your Global Automation Partner

»  Select the GSD file.

»  Click Open.
’ netDevice - Import Device Description X
Look in:| | excom_V204 jl L] c¥ B~
* MName B Date modified Type
) || T204FF9F.GSD 04.05.2015 14:41 GSD File
Quick access -
| | T204FF9F.GSG 04.05.2015 14:36 G5G File
Desktop
™
Libranes
This PC
N&wark
< »
File name: | T204FF9F ~] Open

Flesoftype:  |PROFIBUSGSD ("gs™"gsd gse’gsf)  v| Cancel _ |
Fig. 5: Select the GSD file

= A query window for selecting the graphical representation opens. The graphical display
enables a distinction to be made between devices created in the configurator.

» Click Yes to import the corresponding graphic file in bitmap format.

netDevice - Import Device Description

! ) ) Do you want to import the corresponding bitmap file for device
L+ 4 description T204FFSF.G5D?

Yes MNe

Fig. 6: Import a bitmap file

= A selection window for the bitmap file opens.
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» At the bottom of the window, select the file type Bitmap (*.db; * bmp) from the drop-
down menu.

»  Select the desired bitmap file.

»  Click Open.
B netDevice - Import Icon EXCOM--N for Desription File T204FFOF.GSD X
Lookin: | | excom_V204 v @B
* Name - Date modified Type
) excom--D 28.04.2015 06:16 Bitmap irr
Guick access | = excom--N | 28.04201506:16  Bitmap in|
V4 excom--5 2804.201506:16  Bitmap irv
Desktop
m
Libraries
This PC
Network
< I >
Files of type: Bitmap (* dib;* bmp) Ll Cancel |
W

Fig. 7: Select the bitmap file

=  After the import is successfully completed, a query window opens. The device catalog

must be reloaded.
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» Click Yes.

Import Device Description
o Imported files:
Device description files 1
Icon or bitmap files 1
Do you want to reload the catalog?

e ] w

Fig. 8: Load the device catalog
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43 Creating an excom station and excom modules
The excom station and excom modules must be added to the PROFIBUS configuration. To do
this, the GSD file must be installed.

» Inthe right side bar, select the GSD file excom(2.0.4) and drag and drop it to the
PROFIBUS line in the project window.

netDevice

A | =1 Profibus DPV1 A
@0 Master

. =] Slave

—§5 COMX 100XX-DP/DPS

ALP121[ALP121]<2>(#1)

&

> ]\ Fieldbus (Vendor  DTM Class /
DTM: GSD Slave
Info: -

excom (2.0.4)[excom (2.0.4)]<3> Vendor:  Yokogawa Electric Corporation
! Version:  2.0.3.2
W Date: 2011-11-02
Device: excom (2.0.4)
Info: [T299FF9F.GSD]

Vendor:  Hans Turck GmbH & Co. KG
Version:  2.0.4
Date: 2022-03-14

Fig. 9: Add the device by drag and drop

» To open the excom station configuration, double-click the excom(2.0.4) device.

»  Alternatively: Right-click on the excom(2.0.4) device and click Configuration... in the
context menu.

ALP121[ALP121]<2>(#1)

&

excom (2.0.4)[excom (2.0.4)]<3>

Cut

Copy
Paste

Configuration...

Simulation...
Additional Functions >
Delete

Symbolic Name...
Fig. 10: Click Configuration...

=  The configuration window opens.
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Integrating the excom system with Centum VP
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Creating an excom station and excom modules

Your Global Automation Partner

The excom modules must be selected from left to right according to their arrangement on the
module rack. The GDP... gateway only needs to be selected once in the case of redundancy.

»  Under the Navigation Area click 2 Modules.

» Inthe Available Modules window, select the excom modules and add them to the con-

figuration using Append. The slot numbering is displayed automatically.
In this example, the following excom modules are selected:

Gateway GDP C

DM80 digital input module
DO040. digital output module
AIH40 1H analog input module
AOH40 analog output module

'- netDevice - Configuration excom (2.0.4)[excom (2.0.4)]=3=

— a *
= IO Device: excom {2.0.4) Device ID: OxFF3F
DT Vendar: Hans Turck GmbH & Co, KG Vendor ID: -
Navigation Area Modules
= Cnnéiguratlion Available Modules:
Eners | | Module | Inputs | Owputs | In/Out | Idertifier M
= Modules AlH40 8H a0 0 0 B 0653, 00E
Parameters AlH41 8 0 0 (e 03, 113
Groups AlH41 1H 12 0 0 (ed Od5, B4
Extensions AlH41 4H 24 0 0 Ced 1, 0B, e 15
DPV1 AIH4‘I 8H 0 H (e, (B3, B 16
DPV2 : E__E_ 0cd3.018
Redundancy AOH4D1H (eC 1, Dot 3, bed 1, B 1C
W AMHAN AW e n n ™1 A AT 10
=3 Device Description
Device

Insert | | Append |
Configured Modules:

G5D | | Slot.Index | Madule | imputs | Ouputs | In/Out | Idertfier
} E

i iGDPC 2 2 1] ObeC 1, DbedD), B0, (e 20
2 DMma0 s 2 1 1] OxC 1,000,001, (05
3 D40, 1] 1 1] (81,000,008
4 AIH40 1H 12 1] 1] e 1, (bed B, (e 0C
] ADH4D 1] g 1] (81, bed3, 0 1B
Length of input/output data: 28 bytes (max. 488 bytes)
Length of input data: 16 bytes (max. 244 bytes) Q
Length of output data: 12 bytes (max. 244 bytes)
MNumber of modules: 5 (max. 25)

QK. | Cancel | Help |

Fig. 11: Configuration window
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44 Parameterizing excom modules

Your Global Automation Partner

The gateway or modules can be parameterized in the configuration window. The configuration
window can be opened in the project window by double-clicking, or in the context menu of the

excom station.

» Inthe Navigation Area, under Configuration click > Parameters.

»  Select the desired excom module from the Module: drop-down menu.

» Under Value, double-click or tap the space bar to select the displayed value. A drop-

down menu opens.

» Inthe drop-down menu, set the desired parameter value.

k netDevice - Configuration excom (2.0.4)[excom (2.0.4)]<3>

L

= 10 Device: excom (2.0.4)
DT Vendor: Hans Turck GmbH & Co. KG

MNavigation Area =

Dewvice ID: OxFFaF
Vendor ID: -

Parameters

‘=3 Configuration
jn o3 Module: <Slot 13 GDP C j Display mode: Hexadecimal ﬂ
IModules
roups Mame || Value I
Extensions grid frequency sUHz
DPV1 analog data format status M5B
backplane BATAT M0 145 Ad 1
DPV2 redundancy mode |system redundancy j
P\EdUﬂdEﬂC‘_‘," power supphy off
=3 Device Description cyclic data line redundanc
Device HCIR active :
HCIR WCBC factor
G5D HCIR WCEC base & 100ms)
address offset disable
address offset value DD
CAN redundancy on
SF2 select 0
SF3 select 0

oK | Cancel Apply Help

Fig. 12: Set parameters (GDP C example)
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4471  Example: GDP C

In the following example, the GDP... gateway is parameterized.

» Select Module = GDP C from the drop-down menu.
» Set the parameter values for each channel under Value.

Parameter overview — AlH40

Parameter name Value Meaning
Mains frequency 50 Hz Select afilter:

60 Hz To suppress possible overlays due to mains disturbances in
analog signals, either a 50-Hz filter or a 60-Hz filter can be
selected.

Analog data format MSB status Set the status bit position:

LSB status The status bit of an analog input channel can be mapped

No status into the process input data of the channel and the position
(MSB or LSB) can be determined.

Status MSB: Status bit at bit position 2'°
Status LSB: Status bit at bit position 2°
No status: Measured value without status bit
Module racks MTO08 Select the module rack used:
MT16 MTO8 (8 /0 modules)
MT24 MT16 (16 1/0 modules)
MT24 (24 1/0 modules)
Redundancy mode Off Select the type of redundancy:

Line redundancy
System redundancy

Gateway without redundancy function
Line redundancy
System redundancy

Power supply unit Simple Select diagnostics
Redundant Simple: Both power supplies supply the excom station with
voltage; status information about the redundant supply is
not output.
Redundant: Both power supplies supply the excom station
with voltage and status information about the redundant
supply is output.
HCIR active Off Enable online configuration
On This bit must be set by the PROFIBUS master before the HCIR
sequence starts. During the HCIR sequence, the outputs
retain their last valid value. After the HCIR sequence is
completed, the outputs are set to the current status of the
process values.
HCIR WCBC factor Basis x 1 Select the factor for generating the max. holding time of the
Basis X 16 outputs between old and new configuration
HCIR WCBC basis 0...63 (default: 5) Define the basis of the changeover time
(x 100 ms)
Address offset Off Activate or deactivate address offsets for line redundancy
On

Offset value

0...124 (default: 0)

Select address offsets for generating a virtual address for the
redundant gateway (default value: 0, must be at least 1)

CAN redundancy

Off
On

Activate or deactivate internal communication redundancy
(gateway module communication)

SF2/SF3

Reserved

Hans Turck GmbH & Co. KG | T +49 208 4952-0 | more@turck.com | www.turck.com
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Parameter name Value Meaning

The following parameter applies only to the gateway configuration with the suffix "C" (cyclic data) or "YO" (control

data for Yokogawa redundancy) for ALP111.

Cyclic data The default value of this parameter is "0" and must not be
changed.
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4472  Example: DM80

The DM80 digital module is parameterized in the following example.

» Select Module > DM80 from the drop-down menu.
» Set the parameter values for each channel under Value.

DM&0: Parameter overview

The parameters are set in pairs for the particular two channels (1/2, 3/4,5/6, 7/8).

Parameter name Value Meaning
Short circuit monitoring  On Activate or deactivate the short circuit monitoring in pairs
Off The output signal can only be monitored when activating
the output.
Wire-break monitoring On Activate or deactivate the wire-break monitoring in pairs
Off The output signal can only be monitored when activating
the output.
Substitute value strategy  Min. value Set substitute value per channel: minimum (0), maximum (1)
Max. value or last valid value (0 or 1)
Last valid value
Effective direction Input Set channels as input or output
Output

Input: The channels of the module are switched in groups as
inputs (1/2, 3/4,5/6, 7/8). The DM80-N S and DM80-N S8|
variants provide a status.

Output: The channels of the module are switched as outputs
in groups (1/2, 3/4,5/6, 7/8). The DM80-N S variant on the
other hand also provides a status for the outputs.

Polarity Normal Activate or deactivate signal inversion
Inverted
Debouncing Off Set the additional input signal loss
10 ms
20 ms
50 ms
Channel 1...8 Active Activate or deactivate channel 1...8
Inactive If a channel is not used, it can be switched off to prevent

unwanted fault signals.
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443  Example: DO40

The DO40 digital module is parameterized in the following example. The parameters are
presented individually for each channel.

» Select Module - D040 from the drop-down menui.
» Set the parameter values for each channel under Value.

DO40: Parameter overview

Parameter name Value Meaning
Short circuit monitoring  On Activate or deactivate short-circuit monitoring channel-by-
Off channel
The output signal can only be monitored when activating
the output.
Wire-break monitoring On Activate or deactivate wire-break monitoring channel-by-
Off channel
The output signal can only be monitored when activating
the output.
Substitute value strategy Min. value Set substitute value per channel: minimum (0), maximum (1)
Max. value or last valid value (0 or 1)
Last valid value
Polarity Normal Activate or deactivate signal inversion
Inverted
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444  Example: AIH40

The AIH40 analog module is parameterized in the following example.

» Select Module = AIH40 1H from the drop-down menui.
» Set the parameter values for each channel under Value.

AIH40: Parameter overview

The default parameter values are shown in the following table in bold type. The module can be
configured with 1, 4 or 8 HART values. You will find more information in the excom manual.

Parameter name Value Meaning
Short circuit monitoring  On Activate or deactivate short-circuit monitoring
Off
Wire-break monitoring On Activate or deactivate wire-break monitoring
Off
Substitute value strategy  Min. value Set a substitute value per channel: minimum, maximum or
Max. value the last valid value
Last valid value
HART status/measuring  Off/0...20 mA Off/0...20 mA: Dead zero without HART status request; dia-
range Off/4...20 mA gnostics for wire break and measuring range undershoot
On/4...20 mA not possible

Off/4...20 mA: Live zero without HART status request; dia-
gnostics for wire break and measuring range undershoot
active

On/4...20 mA: Live zero with HART status request; dia-
gnostics for measuring range undershoot and overshoot as
well as wire break and short circuit monitoring active

Filter (PT1) Off Set the software filter to generate an average value
0.1s
265
29.2s
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445  Example: AOH40

The AOH40 analog module is parameterized in the following example.

» Select Module > AOH40 from the drop-down menu.
» Set the parameter values for each channel under Value.

Parameter overview — AOH40

The default parameter values are shown in the following table in bold type. The module can be
configured with 1, 4 or 8 HART values. You will find more information in the excom manual.

Parameter name Value Meaning

Short circuit monitoring  On Activate or deactivate short-circuit monitoring
Off

Wire-break monitoring On Activate or deactivate wire-break monitoring
Off

Substitute value strategy  Min. value Set a substitute value per channel: minimum, maximum or
Max. value the last valid value
Last valid value

HART status/measuring  Off/0...20 mA Define HART status / measuring range

range Off/4...20 mA Off/0...20 mA: Dead zero without HART status request and
On/4...20 mA wire break inactive

Off/4...20 mA: Live zero without HART status request and
wire break active

On/4...20 mA: Live zero with HART status request (HART
diagnostics active) and wire break active
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4.5  Configuring the PROFIBUS module ALP121
» To open the configuration of the PROFIBUS module ALP121, double-click the
ALP121[ALP121]<2>(#1) device.

»  Alternatively: Right-click on the ALP121[ALP121]<2>(#1) device click Configuration... in
the context menu.

ALP121[ALP121]<2>(#1)

[

Cut
Copy
Paste

1]<3=
Configuration...

Simulation...
Additional Functions .
Delete

Symbaolic Name...

Fig. 13: Context menu (PROFIBUS module ALP12)

=  The configuration window opens.
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In the Navigation Area left sidebar, under Configuration select > Bus Parameters.
Make the desired PROFIBUS settings.
If parameters are marked with a yellow exclamation point icon: Click Adjust.

If Adjust has been clicked: The settings for the parameters Target Rotation Time, Watch-
dog Control Time and Data Control Time are adjusted automatically.

J vwvy

’- netDevice - Configuration ALP121[ALP121]<2>(#1) — O *
10 Device: ALP121 Device ID: Ox45F1
Vendor: ‘fokogawa Electric Corporation Vendor ID: 0x0037
Mavigation Area B Bus Parameters

Profile: [PROFIBUS DP Master Redundant |

‘4 Configuration
(=8

‘=4 DPM Management | Bus Parameters

Bus Monitoring

DPM Settings Baud Rate: 1500 +| kBit)s Station Address: 2 :I
DPM Layout
Slot Time: 1000 it Target Rotation Time: 32846 Bt
Station Table g
Master Settings Min. Station Delay Time: 11 Bit = 21.8973 ms
Time Sync Max. Station Delay Time: 150 tBit  GAP Actualization Factor: 10
Quiet Time: v} hit Max, Retry Limit: 1
Setup Time: 1 iBit Highest Station Address (HSA): 125
Data Control Time: 24000 ms [ Overwrite slave specific Watchdog Control Time
Min. Slave Interval: 2000 ps Watchdog Control Time: 4000 ms
Calculated Timing = -
Tid1: 37 tBit

Tid2: 150 tBit ' Values marked with this symbol should be Adjust
. adjusted to changes in the topalogy.

oK. | Cancel Help

Fig. 14: Configuration window
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Your Global Automation Partner

Setting the PROFIBUS address

To set the PROFIBUS address, proceed as follows:
| 2

In the Navigation Area, under DPM Management select = Station Table.
>

Under Station Ad..., select the PROFIBUS address by clicking in the window in the drop-
down menu.

r netDevice - Configuration ALP121[ALP121]<2>(21)

= (] X
ﬁ 10 Device: ALP121

Device ID: 0x45F1
Vendor: Yokogawa Electric Corporation Vendor ID: 0x0037

Navigation Area B Station Table
K23 Configuration

) | Activate [Station Ad... | Device I
-4 DPM Management .

PE.......L2L. 3fxcom (20.4)
DPM Settings

DPM Lavo

H Station Table

Master Settings

Name |

Vendor |

excom (2.0.4) Hans Turck GmbH & Co. KG

Time Sync

Fig. 15: Set the client station address

If Activate is not checked, the device configurations can be set before commissioning.

Define input and output signals

>

In the Navigation Area, under DPM Management select 2> DPM Layout.
>

In the drop-down menu select Inputs or Outputs.
» Select the desired settings.

’- netDevice - Configuration ALP121[ALP121]< 2> (#1)

= O X
10 Device: ALP121 Device ID:
Vendor: ‘Yokogawa Electric Corporation

0x45F 1
Vendor ID: 0x0037

Navigation Arez B DPM Layout
{3 Cenfiguration
Bus Paramete v|| Defragment ‘ /# Attention: Defragment function will affect all siaves!
DPFA Settings Station Add... |S|ot.|nd...| Device/Module | Type | Tag | Length | Address
excom (2.0.4) excom (2.0.4] 15 0
Tation Table 1.1 1 word input W Input_01 2 0
21 1 byte input 1B Input_02 1 2
Master Settings 41 6 word input W Input_03 12 3
Time Sync

Fig. 16: Define input and output signals

Save the PROFIBUS module configuration

»  Click on the Save icon in the upper-left corner.
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46  Setsystem redundancy and HCIR

46.1  System redundancy for ALP121
System redundancy can be established for Centum VP with two PROFIBUS modules ALP121.

In system redundancy, two independent fieldbus masters are connected to a single excom
station. The two gateways of the excom station are set into cyclic data exchange via the two
independent fieldbus masters. The redundant gateways must be configured and parameter-
ized identically via the two fieldbus masters.

Host Redundancy-connection Host
reserve
Master Master
PROFIBUS-DP
° RS485
4 @
s 5] excom

MT16-N

|

-—————

Fig. 17: System redundancy
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Set system redundancy
If not already done, set the system redundancy in the gateway:

» Inthe Gateway configuration window, under Navigation Area click = Configuration =
Parameters.

»  Set the redundancy mode parameter to system redundancy.

b netDevice - Configuration excom (2.0.4)[excom (2.0.4]]<3> — O *
= 10 Device: excom {2.0.4) Device ID: OxFF9F
DT Vendar: Hans Turck GmbH & Co. KG Vendor ID: =
Navigation frea [ Parameters
=3 Configuration .
— Module: <Slot 1> GDP C j Display mode: Hexadecimal j
Modules
roups MName || Value I
Extensions grid frequency a0Hz
DPV1 analog data format status M5B
backplane e ey
DPV2 redundancy mode |system redundancy
Redundancy power supply off
{23 Device Description cyclic data line redundanc
Device HCIR active i :
HCIR WCBC factor
G0 HCIR WCEC base  100ms} 10
address offsst disable
address offset value AL
CAN redundancy on
SF2 select 0
SF3 select 0

0K | Cancel Apply Help

Fig. 18: Set system redundancy (GDP C example)
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To activate system redundancy in the control system, proceed as follows:

» In Centum VP, select the node in the All Folders left sidebar.
» Open the NODE1 node.

» Right-click 3ALP121.

» Click Properties...

System View (CENTUM VP) - NODET
File Edit View Tools Load Project FCS HIS Help

| m| | X|%|=|@]F +]$] %|w|E]=

Folders ed Folder : NODE1
=-fE SYSTEM VIEW | Type [ M
=% M:‘F'JT ALF111(Foundation Fieldb...  2(
i i COMMON ALF111(Foundation Fieldb...  2(
-5 BATCH
=8 Fcso102 Open
- ~ZI CONFIGURATION Delete
[)-38 SEQ_LIBRARY
= Cut Ctrl+X
| Copy Ctrl+C
View »
»
E MESSAGE Arrange lcons
- [ FUNCTION_BLOCK Tools ,
- @-¢) DISPLAY
- = HISD164 Load )
Domain Properties...
Properties...

Fig. 19: Open the 3ALP121 context menu
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» Select the Type and Position tab.
»  Check whether Duplicate Next Card is checked.

Properties

| oo and P | st Do |

r~ IOM Type

Type | ALP121(Profibus-DP Communication)

r Installation Posttion

St =]

¥ Duplicate Next Card

~Output Type
' Output in a lump € Dutput immediately

™ High Speed Read

DﬂCulll-t|

Fig. 20: Check system redundancy
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»  Select the Set Details tab.
»  Under Type of Redundancy, select = Network Redundancy.

Properties
Type and Position | Set Details
IOM Category Profibus-DP Communication
IOM Type ALP121(Profibus-DP Communication)
Slot 3
~ Type of Redundancy

Prefixed slave

— Action when module/channel fail detected
[~ Set all comesponding module input data to IOP

¥ Set all comesponding module output data to OOP
Head of Slot numbers of Slave Device in Message

device channel number in alarm message

Command(L)

Fig. 21: Select the redundancy type
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View the status of the system redundancy

The status of the system redundancy can be viewed. Redundancy may be activated or not ac-
tivated.

» Inthe left sidebar, select Navigation Area > Configuration > Redundancy.

»  Check whether Activate Redundancy Mode is checked.

» If system redundancy is not activated: Check Activate Redundancy Mode.

r netDevice - Configuration excom (2.0.4)[excom (2.0.4)]<3> — O *
= 10 Device: excom {2.0.4) Device ID: OxFFIF
DT Vendar: Hans Turck GmbH & Co. KG Vendor ID: =
Navigation Area =S Redundancy
%_'_ICmﬁguratlon | [v Activate Redundancy Model
enera
Medules Output Hold Time: ’81— (Time base: 10 ms)
Parameters
Groups Jokerblock
Extensions
DRV ke
DPY2
L4 Redundancy

{4 Device Description
Device
GsSD

oK | Cancel Help

Fig. 22: System redundancy active

46.2  HCRin Centum VP

Yokogawa does not support direct Hot Configuration in Run (HCIR). In the excom gateway, the
HCIR parameter can be switched on and the hold time window can be set.

The HCIR function allows the user to extend the configuration of the I/O modules during opera-
tion or to change parameters of the module channels. The PROFIBUS communication of the ex-
com station is stopped during the HCIR sequence. The hold time of the outputs results from the
set parameters of the HCIR-WCBC basis and the HCIR-WCBC factor (see Parameterizing excom
modaules). All outputs will be frozen for the pre-defined period. Diagnostics are not discontin-
ued during the HCIR sequence.

If the new configuration does not take place within the specified holding time, the outputs
change to the predefined substitute value. The outputs also change to the predefined substi-
tute value if communication is interrupted during the changeover and the watchdog runs.
Centum VP issues a fault signal during this time that the node is not reachable. The message
must be suppressed during the loading process of the new configuration or subsequently ig-
nored. After a successful configuration change, the data is transferred to cyclic bus communica-
tion in accordance with the new configuration and the PROFIBUS node continues to operate
normally.

As an example, the default values of the HCIR-WCBC factor and the HCIR-WCBC basis result in
the maximum hold time:

1% (5% 100 ms) =500 ms
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47  Configure I/O signals

» Inthe All Folders project tree, select the NODE1 node in which the PROFIBUS modules
ALP121 are created.

»  Double-click the 3ALP121 PROFIBUS module.
=  The Start Builder window opens
»  Select Communication I/O Builder and Support Tool.
» Click OK.
stem View (CENTUM VP) - NODE1
File Edit View Tools Load Project FCS HIS Help
| m| | X|&[%(@]m] #] ] o|=|=mlE 2w o
Folders ed Folder : NODE1
=-E& SYSTEM VIEW Name | Type | Modified | comm... |
B-% MYPJT B 1AL ALF111(Foundation Fieldb...  2022/07/05 00:01
: h COMMON B 2aLF111 ALF111(Foundation Fieldb .. 2022/07/05 00:02
= BATCH g aLP121 ALP121(Profibus-DP Comm... 2023fn1f17zu:5e—|
=@ Fesoie B 3ALP1210uwp ALP121(Profibus-DP Comm .. 2023/01/17 20.56
-a gggF]'_GBU&T;O“ Bl sAAI141H AAI141-H(16Channel Curr..  2022/07/05 00:02
" - : eani543-H AAI543-H(16-Channel Cur..  2022/07/05 00:03
) 7ADV551-P ADV551-P(32-Channel Stat... 2022/07/05 00:03
b B sADV151P ADV151-P(32-Channel Stat... 2022/07/05 00:04
Start Builder X

B[ FUNCTION_BLOCK
5L DISPLAY

: " PROFIBUS-DP Configurator
1 HIS0164

* Communication 1/O Builder and Support Tool |

| OK I Cancel |

Fig. 23: Open Start Builder

=  The Communication I/0 Support Tool window with the configured excom modules

opens.
& Communication /O Support Tool MYPIT FCS0102 NODET 3ALP121 - O X
~PROFIBUS communication sett
Selection/Total size : 0/ 15 Wiord
| Assiened element | Station address | Slot | Idex | Slave device name | Tag name of the module | Datatvpe | Size

3 1 1 excom (204) Thput 01 T 1

3 1 1 excom (204) Output_01 (a1} 1

2 2 i excom (2.04) Thput 02 B i

2 2 i excom (2.04) Output 02 QB i

2 3 i excom (2.04) Output 03 QB i

3 4 i excom (2.04) Tnput 03 T i

3 5 i excom (2.04) Output 04 (a1} 4

Update Close

Fig. 24: Communication I/0 Tool

Hans Turck GmbH & Co. KG | T +49 208 4952-0 | more@turck.com | www.turck.com V01.00 | 2023/03 | 32



»  Close the Communication I/O Support Tool window.
» Inthe Communication I/O Builder window, configure the I/0 signals.

ﬂFile Edit View Tools Window Help -8
|i|ﬂ a||3|| % %@ [D [@
E = - - -
bl 1 1 Bits Normal excom Station 3 - Input_01 %%DMBO_IN
R B EaEd -
hd d 1 1 Bits Normal excom Station 3 - Output_02 %%DMB0_OUT
o - EaE -
bl 1 1 Bits Normal excom Station 3 - Output_03 %%D040
| - w -
bl 6 1 No Normal excom Station 3 - Input_03 SHATH40_1
b - hd - $SAIH40 2
w| - e -
| w - w -
w | - w -
EaR - EaE -
Al 8 1 No Normal excom Station 3 - Output_04 $3AOH40_1
| w - w -

Fig. 25: Configure 1/O signals

» Load the configuration to the controller via File = Download.

Communication /O Builder - [PjMYPRIT Stn:FC0102 F
File | Edit View Tocls Window Help
Open... Ctrl+0
Close

Save Ctrl+5

Sp
External File ¥
Properties

Print Preview

Print... Ctrl+P

Recent File

Exit Communication |70 Builder

Fig. 26: Load the configuration to the controller

»  Alternatively: Close the window and confirm the query window with Yes.
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Configure I/O signals in Excel

The 1/O signals can also be configured via Excel instead of configuring the I/0 signals in the
Communication I/O Builder.

»  Under File = External File, export the 1/0 signal configuration table as a csv file.
»  Configure I/0O signals in the csv file.
» Under File = External File, import the I/0 signal configuration table as a csv file.

Communication |/O Builder - [Pjt:MYPJT 5tn:FCS0102 File:CommDataWW.edf]

File

| Edit View Tools Window Help

la

Open... Ctrl+0

" rogran Neme |

Save Ctrl+S
Save As...

D ] e

Properties e

Print Preview
P-mtlll ctl+ P

Download

Recent File

Exit Communication |/O Builder

Fig. 27: Export and import I/O signals as a csv file
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Load the I/O signal configuration to the PROFIBUS module

Once the I/0 signals have been configured, the configuration can be loaded into the PROFIBUS
module ALP121.

» Select the node in the All Folders project tree.

»  Openthe NODE1 node.

» Right-click the 3ALP121 PROFIBUS module.

»  Inthe Tools context menu click 2 PROFIBUS-DP = Download PROFIBUS communica-
tion settings....

[ System View (CENTUM VP) - NODET
File Edit View Tools Load Project FCS HIS Help

T s I Y = O 2 W e 5 ] -
A Folders

=-EE] SYSTEM VIEW A | Name [ | Modfied | Commert |
E-F MYPIT .. 2022/07/0500:01
B3 &k COMMON . 2022/07/05 0002
Efp BATCH .. 2023/01/3119:25
i ﬁén:mummn 2B/01731 1525
2022/07/05 00:02
=-28 SEQ_LIBRARY = 2022/07/05 00:03
off SEBOL_USER |5 :
ﬁ orc squew  |BIA cu Culex | 2022/07/050003
8, UNIT_PROCE! ilea Cuiec | 22750004
[y 10M
-l NODE1 View >
E KEH Arrange Icons >
3 s T ] s
MESSAGE
[ FUNCTION_BLOCI Load > Pre-check before PROFIBUS settings...
" : communication settings...
| % DDWM1 Domain Properties. Save PROFIBUS icati i
% DRO0OS
~-[3% DRO0DG
-5 DROOD7 b
< >

Fig. 28: Load the I/0 signal configuration to the PROFIBUS module
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=  The Downloading confirmation dialog query window opens.

»  Confirm the query Download to FCS? with OK.

Downloading confirmation dialog

Starting generaticn Wed Feb 15 21:30:50 2023
The following differences are detected.
[NXD_database_A]

2023-01-30_18:18:48

[WXD_database B]
2023-02-15_21:19:17

[Master_ Settings]
Result=Not Changed
Busparameter=No

Watchdeg=No
Defragment=No

[Devices_deleted]
Device=5, excom (2.0.4), excom (2.0.4)

Download to FCS 2

0K Cancel

Fig. 29: Downloading confirmation dialog

=  The configuration is loaded to the PROFIBUS module.
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Settings channels

The %WB Tag Number Definition Call(W) is used to assign specific element names for the digital
signals of the individual channels of the modules. The element name is required for later pro-
gramming. In addition, settings can be made for the buttons (display blocks) in the HIS (Human
Interface Station), e.g. the color of the buttons. The element name is composed of %WB fol-
lowed by the position of the signal assignment and the bit position of the signal. An example
element name is %WBO000501. The specification 0005 is derived from the position of the signal
and the 01 for the bit position in a byte or word.

In the %WB Tag Number Definition Call(W) context menu the module channels are assigned
to the signals from the Communication I/0 Builder:

» Select = Tools in the Communication 1/0 Builder.
» Select %WB Tag Number Definition Call(W) in the context menu.

% Communication /0 Builder - [Pjt:MYPIT Stn:FCS0102 File:CommDataWW.edf] -
B} File Edit View Tools Window Help - & x
EEJ @@J 4 Create Default File
ot [ Delete DefouitFile s | Size [ Port chru| Scan | Service Comment Label ~
Specify : BT D R e ) 1 15 Normal excom Station 3 - Output_01 23GHCOM
L abel. Tag/Window Name List... . . .
| Options.. 1 lits  Normal excom Station 3 - Imput_01 %3DMB0_IN
SWW0006 | > * -
SWWO0007 I 1 lits  Normal excom Station 3 - Output_02 %3DMB0_OUT
SWW0008 *| - - - -
SWW0009 e 1 lits Normal excom Station 3 - Output_03 %%D040
SWW0010 - > * -
SWW0011 *| - 3 15 Normal excom Station 3 - Input_03 $3ATHEO0_1
SWW0012 “| - - - - $3ATHE0_2
3WW0013 .| > * - - $3ATH40 3
SWW0014 w|» - - * $3ATHEO0 4
SWW0015 *| - - - >
» | swwo016 .- - - - —
SWW0017 hd 4 1> Normal excom Station 3 - Output_04 $%A0H40_1 .
< >
Message
\ctivate Windows
=tings 1o activate Windows
Position: Line 16 Column 13 Change

Fig. 30: Select the %WB Tag Number Definition Call(W) view

»  Set the tag names and buttons.

@ File Edit View Tools Window Help =
| SR «|@l- |5 @ |
Ll No. | Element [ Tag Name | Tag Comment [iwitch Position Labe]l Label Btal Btn2 |1.v1| Tag M
» (0001 ON, ,OFF, ON Direct Red Red 4 General
0002 ON, , OFF, ON Direct Red Red 4 General
0003 ON, , OFF, ON Direct Red Red 4 General
0004 ON, , OFF, ON Direct Red Red 4 | General
0005| *WB000501 DMB0_ CH1 IN ON, , OFF, ON Direct Red Green 4 General
0006| *WB000502 DME0_CH2_IN ON, ,OFF, ON Direct Red Green 4 General
0007| *WB000503 DMB0_CH3_IN ON, , OFF, ON Direct Red Green 4 General
0008| *WB000504 DMB0_CH4_IN ON, , OFF, ON Direct Red Green 4 General
0009| *WB000S05 DMBO_CHS_IN ON, ,OFF,ON Direct Red Green 4 General
0010( *WB000506 DMBO_CH6_IN ON, ,OFF, ON Direct Red Green 4 General
0011 *WB000507 DMBO_CH7_IN ON, ,OFF,ON Direct Red Green 4 General
0012| WB000508 DME0_CHB_IN ON, , OFF, ON Direct Red Green 4 General
0013| $WB000901 DO401_CH1 ON, , OFF, ON Direct Red Green 4 General
0014| *WB000902 DO401_CH2 ON, , OFF, ON Direct Red Green 4 General
0015| *WB000903 DO401_CH3 ON, ,OFF,ON Direct Red Green 4 General
0016| WB000904 DO401_CH4 ON, , OFF, ON Direct Red Green 4 | General
0017 *WB001101 AIH40_ CH1 RUN, , STOP, RUN Direct Red Yellow 4 General

Fig. 31: Tag names and buttons are set
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» Download channel allocation via File = Download.

Communication [/O Builder - [PjMYPRIT S5tn:FC30102 F
File | Edit VYiew Tocls Window Help

Open... Ctrl+0
Close

Save Ctrl+5

Sp

External File ¥

Properties

Print Preview

Print... Ctrl+P

Recent File

Exit Communication |70 Builder

Fig. 32: Download channel allocation

»  Close the Communication I/O Support Tool window.
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The configured 1/0 signals must be loaded to the PROFIBUS module ALP121:

» Inthe All Folders project tree, select the MYPJT project.
» Click Load in the top bar.
» Inthe context menu, click Download Project Common Section.

System View (CENTUM VP) - MYPJT

File Edit View Tools| Load | Project FCS HIS Help

[il“l -:l ﬁ'l J(l b |E Download Project Common Section

All Folders Download to IOM
=-EE SYSTEM VIEW

E“-.%

Save FCS Tuning Parameter

COMMON Offline Download to FC5
iy %] IEQ;-E::}Z Download to HIS

|21 CONFIGU Download Tag-List
[+)-a83« SEQ_LIBF
Elil IOM

| EI--IIiI NODE Offline Download to BCV

%ﬁu

...... '5:| SWITCH Save BCV Operation Mark

Download 5tatus Display File

Download Tag-List/Gateway Information

|B8l MESSAGH
g FUNCTIO Download to CGW
;f.L DISPLAY

il Lenica Download Common Block

Fig. 33: Download Project Common Section

= A query window opens.
Perform the subsequent download only if a new project has been created.

»  Confirm the query window with OK.

Confirm Download Project Common Section pd

_ Download the common part of project 'MYPJT' to all equalized
4 8% stations?

I OK I Cancel

Fig. 34: Confirm Download Project Common Section

=  Another query window opens.
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» Decide whether to download the domain properties.
»  Confirm the query window with Yes or No.
Confirm Download

. Download Domain Properties, too?
/ |3\ You can download Domain Properties later.

Yes No

Fig. 35: Download domain properties

=  The project download is complete.

For a newly created project or controller as well as basic changes in the program, an offline
download must be carried out in the FCS (controller). The controller is taken offline and re-
loaded.

» Inthe All Folders project tree, select FCS FCS0102.
» Click Load in the top bar.
»  Click Offline Download to FCS in the context menu.

System View (CENTUM VP) - FCS0102
File Edit View Toolsl Load | Project FCS HIS Help

ﬂul -l 2"' )(l ¥ |E Download Project Common Section M
Folders Download to IOM
EJ" ;;;SJ\E;";'EW Save FCS Tuning Parameter | Modfied
- 5% COMMON | Offline Download to FCS > Download
-5l BATCH

] CONFIGU Download Tag-List
[#-28% SEQ_LIBF

i Download to HIS
=8 s fFCs0102

Download Status Display File

=-Hi) 1om

- =i NODE Offline Download to BCV

| %g ;j: Download Tag-List/Gateway Information
-~ ] SWITCH Save BCV Operation Mark

I:‘lf:gﬁé[ Download to CGW

-3 DISPLAY

_ | HIS0164 Dc.vr'ulcad Common Block

Fig. 36: Offline Download to FCS

= A query window opens.
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»  Confirm the query window with OK.
Confirm offline download to FCS. =

A Perform offline download to Project 'MYPJT' FC5 'FCS0102" ?

I 0K I Cancel

Fig. 37: Confirm offline download to FCS.

=  Another query window opens.
»  Confirm the query window with Yes.

Confirm to save FCS Tuning Parameter

When offline downloading to FCS, the tuning parameters will be lost.
Save tuning parameters of Project:' MYPJT',Station:'FCS0102'7

o

=  The offline download of the project is complete.

Fig. 38: Confirm to save FCS Tuning Parameter
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Set 1/0O signals in Control Drawing

>

Select the function block in the All Folders project tree.

»  Open the function block FUNCTION_BLOCK.

>

Right-click DRO0O1.

» Click Open.

System View (CENTUM VP) - FUNCTION_BLOCK
File Edit View Tools Load Project FCS HIS Help

Fig. 39: Open the function block

=  The Control Drawing Builder opens.

ﬂm|:|| @ X & |E||m) f|~$

@ &

B @ SYSTEM VIEW
-5 MYPJT

BB COMMON
&5 BATCH
=8 I FCS0102

IOM

------ . CONFIGURATION
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Integrating the excom system with Centum VP WU C K

Set I/O signals in Control Drawing Your Global Automation Partner

Set the function block
Function blocks can be added in the Control Drawing Builder.

»  Add function block: Right-click in the main window. In the context menu click Insert >
Function Block....

»  Alternatively: Click the function block icon in the navigation bar.

% Control Drawing Builder - [Pjt:MYPJT Stn:FCS0102 Draw:DR00DT File:DRO00T.df - [100%]] - X
File Edit View Inset Format Tools Draw Smart-Part Window Help
@@ SR &|s|eof HEeal® [ -] &% Blet|Af] E|#
i 2| =] =] B|z|u] - = =|m|
Tag Name NIty o Ty oy ooy Tosey oy Toony (o Tosoyy ooy ooy oy Toom, (- Reoy ooy ( Tssoy oy Teom, (- Teso ooy Tsoy 4y Toomy - Tosoy 1 ooy Tssoy
o1 [DM2D0-1 ~
002 |DM2DO-2
003 |DM2DO-3

£l L

{ DO401_CH1 ]

Properties

£ IR WL TR

Fieldbus Block List

Device Management Tool

Smart-Part Manager

Insert > [ Function Block...

Wiring

¥ Selection Mode

PO N PR FEWEL NN

< >

Ready X:454 V:130 1024x 686  |Select

Fig. 40: Add a function block in the Control Drawing Builder

=  The Select Function Block window opens.
In the following example, the Logic Operation Blocks function block is set with an OR function:

» Inthe project tree, select Logic Operation Blocks.
» Select OR.
» Click OK.

Select Function Block X

H- General-Purpose Calcula
HHHHH |}{zdel Name |OR - |

#- Operation
- Switch Instruments
- Sequence Elements 1

+- Faceplate Blocks

[
|\-\ Logic Operation Blocks Symbol

AND

v Symbol List >>

| OK | Cancel ‘

Fig. 41: Select the function block

Once the function block is added, it can be set in the Function Block.
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Integrating the excom system with Centum VP WU C K

Set I/O signals in Control Drawing Your Global Automation Partner

» If the Select Function Block window is not yet closed: Close the window.
»  Double-click the function block.

*C50102 Draw:DR0001 File:DR0O001.edf - [100%]]
ols Draw Smart-Part Window Help

[0y <] B|[% =|ef|Al ] |
— ] 8] [ i -1 =m

11y [50 g gy Jrooy o 150y g Ja00, g fas0y o [300, [as0y o Je00, ) Jesdg o 00, [sso; o [eoo, ;| [eso; oy [700, 4 [750, ) [600)

85

Properties

Cut Ctrl+X
Copy Ctrl+C

Delete Del

Edit Detail

Fieldbus Block List

Device Management Teol

Search for related tags

Insert
Block Comment

Delete Symbeol

Block Parameter

Selection Mode

Undo Ctrl+Z

Fig. 42: Set the function block
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Integrating the excom system with Centum VP WU C K

Set I/O signals in Control Drawing Your Global Automation Partner

» Inthe open Function Block window, select the Function Block tab.
»  Select the desired settings.

Function Block

Common Function Block l

Tag Name DM2DO-1
Model Name OR _I
Tag Comment [

Scale  Low limit value
ﬁ

High limit value

Input Signal Conversion

J Symbol

Totalizer Time Unit

Engineering unit symbal

Tag Mark |Gene1“:|| j
Alarm Level |Medium ﬂ
Lvi 4 1.|
J Symbol List J
Upper Equipment Name | ﬂ

Fig. 43: Set the function block
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Integrating the excom system with Centum VP WU C K

Set I/O signals in Control Drawing Your Global Automation Partner

Connect function blocks

To interconnect signals and create program sequences or step sequences, connect the function
blocks.

»  Click on the wiring icon in the top bar.

"4 Control Drawing Builder - [PjzMYPIT Stn:FCS0102 Draw:DRO00Z File:DRO0DZ.edf - [100%]]
File Edit View Insert Format Tools Draw Smart-Part  Window Help

B|d|@ Sl blw@o] H#H e[ &) [00s 4] &[N %@Al || il
| Syatem J|'_c‘ Jl‘.‘a:‘.:&: : JIM L ||Wil':eﬂ = J

I - [ - R N I P 1

Fig. 44: Wiring icon

»  Select the start point at the start block and connect it to the target block by double-click-
ing.

|.: M2D0-3 T

Fig. 45: Connect the function block
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Set I/O signals in Control Drawing Your Global Automation Partner

Set digital input and output signals
The Link Block = PIO function block must be set for each digital input and output signal.

» Inthe project tree, select Link Block.
» Select PIO.
» Click OK.

Select Function Block X

+

-Operation A
Switch Instruments
Sequence Elements 1
Faceplate Blocks

Logic Operation Blocks

Model Name |PIO -

[+

B[

Sequence Elements 2
Batch Data

[+ [+

[#

Sequence [M-Size]
Sequence [L-Size]
#-Unit Operation

- Unit Instruments

[=- Link Block

[+

Be10]
ARERIN
AREAQUT
v AAAJ Symbol List ji:
< »

0K Cancel |

Fig. 46: Select the function block

=  The window closes.
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Set I/O signals in Control Drawing Your Global Automation Partner

»  Double-click the function block.

»  Alternatively: Right-click on the function block and click Properties... in the context
menu.

» Inthe open window, select the Link Block tab.
» Under Connection Information, set the destination or source signal.

Link Block
Comman | Link Block
Type FIC -

Connection Information “WB000501

Symbol

J Symbol List J

OK | Cancel Apply

Fig. 47: Set the link block
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Set I/O signals in Control Drawing Your Global Automation Partner

Set analog input and output signals

The Input Indicators = PVI function block must be set for each analog input and output sig-
nal.

» Inthe project tree, select Input Indicators.

»  Select PVI.

» Click OK.

Select Function Block X

E-Regulatory Control Blc A
— S Model Name |PVI -
|; Input Indicators ]

BVI-DV
Controllers

-Manual Loaders
Setters Symbol
Limiter

Selectors

S
S
[

Signal Distributors
Pulse Count Input B
-Arithmetic Calculat

Analog Calculation

Ruxiliary

¥S Instruments it T

Frnndarinn Fialdhnalt ymbol List | >>
>

OK | Cancel ‘

e [ - [ - [ - B

Fig. 48: Select the function block

=  The function block is set.

»  Right-click on the function block (here: AI2AO PVI).
»  Select Edit Detail in the context menu.

Ctrl+X
Copy Ctrl+C
Delete Del

Fieldbus Block List

Device Management Tool

Search for related tags

Insert
Block Comment

Delete Symbol

v Selection Mode

Fig. 49: Set the function block
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»  Click the Show/Hide Detailed Setting Items icon in the navigation bar.

=  The tabs Tag, Input, Alarm, Output, Connections and Others appear next to the Basic
tab.

| B2 Function Block Detail Builder - [PjtMYPJT Str:FCS0102 Draw:DRO002 File:AI2AO.edf - Function Block Detail Definition]
File Edit View Tools Window Help

&|u|z|e S| «|=|el-|[DE]

Zdit Window  [Function Block Detail Dez[Show/Hide Detailed Setting Items|

Basic I'I'a.g I Input | Alarm | Outputl CanectionI Obhersl

Fig. 50: Show tabs
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» Under the Basic tab, open the Input Signal Conversion drop-down menu.
» SUBSYS: Select Communication Input.

File Edit View Tools Window Help

&L mle| Sr| (%@l D= |

Function Block Detail Builder - [Pjt:MYPJT Stn:FCS0102 Draw:DR0002 File:AlZAQ.edf - Function Block Detail Definition]

Edit Window

|Function Block Detail Definivien v| |

l Input l Alarm I Outputl Connectionl Othersl

SQRT: Square
BTHPUL: Pul:

LINEAR:No
SQRT:Square Root
BTHPUL:Pulse Train Input

SUBSYS:C

on Input

Fig. 51: Set Input Signal Conversion

» Under the Input tab, select the desired settings (here: High limit value).

File Edit View Tools Window Help

w2 SR =@ [OF

Edit Window

I!‘metinn Block Detail Definition ¥|
==

Function Block Detail Builder - [Pjt:MYPJT 5tn:FCS0102 Draw:DR0002 File:Al2AQ.edf - Function Block Detail Definition]

Input IAlnrm I ()utputl Connectionl Othersl

Fig. 52: Set the high limit value

Hans Turck GmbH & Co. KG | T +49 208 4952-0 | more@turck.com | www.turck.com

V01.00 | 2023/03 | 51



» Under the Output tab, open Output Signal Conversion drop-down menu.
» SUBSYS: Select Communication Output.

» The Data Conversion Gain and the Data Conversion Bias.

Function Block Detail Builder - [Pjt:MYPJT Stn:FCS0102 Draw:DRO002 File:Al2AQ.edf - Function Block Detail Definition]
File Edit View Tools Window Help

0w SR % Bie-|[F @

Edit Window

|Function Block Detail Definition |

Basic | Tag | Input I Alarm | Output IConnectionl Otheral

Fig. 53: SUBSYS : Communication Output

Example: Connect the analog input signal to an analog output signal
» Select the Connection tab.

» Under Measurement Input (IN), use the designation (here: %%AIH40_1) from the Com-
munication 1/0 Tool.

File Edit View Tools Window Help

@ H|Ee SR &|=e-|[OE

Function Block Detail Builder - [Pjt:MYPIT S5tn:FC50102 Draw:DR0002 File:AlZAQ.edf - Function Block Detail Definition]

Edit Window

|Function Block Detail Definition v| |
Basic |Tag

|Inp|1t IAlam IOutpul: Connection Iotherﬂl

Fig. 54: Measurement Input (IN)
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Integrating the excom system with Centum VP
Set I/0 signals in Control Drawing

Load the settings to the FCS

Your Global Automation Partner

Once the settings have been made, the Control Drawing must be loaded to the FCS.

» Inthe top navigation bar, click File — Download.

%4 Control Drawing Builder - [Pj:MYPJT Stn:FCS0102 Dr:
fm Edit View Insert Format Tools Draw

s

Open... Ctrl+0 |
|: Close '
[ | Save Ctrl+S

001 Save As...

L Create Working File

| 09 External File >
Properties

Print Preview
Print... Ctrl+P

Latest File
Exit Control Drawing Builder.

Fig. 55: Load the settings to the FCS

»  Confirm the Downloading confirmation dialog query window with OK.

Downloading confirmation dialog

Starting generation Thu Mar 09 01:26:24 2023
Detecting difference start

Change Generation Time of Station

Change ERecord Data DMZ2D0-3 3BL25695
Change Generation Time of Area

Detecting difference end

Download to FCS 2

oK Cancel

Fig. 56: Query window
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Turck subsidiaries — contact information

Your Global Automation Partner

5 Turck branches — contact data

Hans Turck GmbH & Co. KG | T +49 208 4952-0 | more@turck.com | www.turck.com

Germany

Australia

Austria

Belgium

Brazil

Canada

China

Czech Republic

France

Hungary

India

Italy

Japan

Hans Turck GmbH & Co. KG
WitzlebenstralRe 7, 45472 Milheim an der Ruhr
www.turck.de

Turck Australia Pty Ltd
Building 4, 19-25 Duerdin Street, Notting Hill, 3168 Victoria
www.turck.com.au

Turck GmbH
Graumanngasse 7/A5-1, A-1150 Vienna
www.turck.at

TURCK MULTIPROX
Lion d'Orweg 12, B-9300 Aalst
www.multiprox.be

Turck do Brasil Automacéo Ltda.
Rua Anjo Custédio Nr. 42, Jardim Andlia Franco, CEP 03358-040 Séao Paulo
www.turck.com.br

Turck Canada Inc.
140 Duffield Drive, CDN-Markham, Ontario L6G 1B5
www.turck.ca

Turck (Tianjin) Sensor Co. Ltd.

18,4th Xinghuazhi Road, Xiging Economic Development Area, 300381
Tianjin

www.turck.com.cn

TURCK s.r.0.
Na Brne 2065, CZ-500 06 Hradec Kralové
www.turck.cz

TURCK BANNER S.A.S.

11 rue de Courtalin Bat C, Magny Le Hongre, F-77703 MARNE LA VALLEE
Cedex 4

www.turckbanner.fr

TURCK Hungary kft.
Arpéd fejedelem utja 26-28., Obuda Gate, 2. em., H-1023 Budapest
www.turck.hu

TURCK India Automation Pvt. Ltd.

401-403 Aurum Avenue, Survey. No 109 /4, Near Cummins Complex,
Baner-Balewadi Link Rd., 411045 Pune - Maharashtra
www.turck.co.in

TURCK BANNER S.R.L.
Via San Domenico 5, IT-20008 Bareggio (M)
www.turckbanner.it

TURCK Japan Corporation
ISM Akihabara 1F, 1-24-2, Taito, Taito-ku, 110-0016 Tokyo
www.turck.jp
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Turck subsidiaries — contact information WU C K

Your Global Automation Partner

Korea Turck Korea Co, Ltd.
B-509 Gwangmyeong Technopark, 60 Haan-ro, Gwangmyeong-si,
14322 Gyeonggi-Do
www.turck.kr

Malaysia Turck Banner Malaysia Sdn Bhd
Unit A-23A-08, Tower A, Pinnacle Petaling Jaya, Jalan Utara C,
46200 Petaling Jaya Selangor
www.turckbanner.my

Mexico Turck Comercial, S. de RL de CV
Blvd. Campestre No. 100, Parque Industrial SERVER, C.P. 25350 Arteaga,
Coahuila
www.turck.com.mx

Netherlands Turck B. V.
Ruiterlaan 7, NL-8019 BN Zwolle
www.turck.nl

Poland TURCK sp.z.0.0.
Wroclawska 115, PL-45-836 Opole
www.turck.pl

Romania Turck Automation Romania SRL
Str. Siriului nr. 6-8, Sector 1, RO-014354 Bucuresti
www.turck.ro

Sweden Turck AB
Fabriksstraket 9, 433 76 Jonsered
www.turck.se

Singapore TURCK BANNER Singapore Pte. Ltd.
25 International Business Park, #04-75/77 (West Wing) German Centre,
609916 Singapore
www.turckbanner.sg

South Africa Turck Banner (Pty) Ltd
Boeing Road East, Bedfordview, ZA-2007 Johannesburg
www.turckbanner.co.za

Turkey Turck Otomasyon Ticaret Limited Sirketi
Indnl mah. Kayisdagi c., Yesil Konak Evleri No: 178, A Blok D:4,
34755 Kadikoy/ Istanbul
www.turck.com.tr

United Kingdom TURCK BANNER LIMITED
Blenheim House, Hurricane Way, GB-S511 8YT Wickford, Essex
www.turckbanner.co.uk

USA Turck Inc.
3000 Campus Drive, USA-MN 55441 Minneapolis
www.turck.us
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